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Preface

Before you begin

Please read this user manual before installing 
SurveyCERT™ to your PC or PDA.

Read your Pocket PC user documentation thoroughly 
before attempting to bond the RD8000 Receiver to your 
Pocket PC or similar device.

Note that this manual and all its contents are subject to 
change. Radiodetection products are under continuous 
development.

Radiodetection Limited reserves the right to modify the 
product without notice and some product changes may 
have taken place after this user manual was published.

Contact your local Radiodetection dealer or visit 
www.radiodetection.com for the latest information about 
the RD8000 product family, including this manual and the 
bundled software

Important Notice 

Radiodetection makes every effort to ensure that all 
technical information, statements and recommendations 
about RD8000 products are based on information 
believed to be reliable, but the accuracy or completeness 
thereof is not guaranteed. In no event shall Radiodetection 
be liable for any loss, inconvenience, damage or problems 
caused through use of any equipment or software.

Before using any RD8000 product (including 
SurveyCERT™), the user should determine the suitability 
of the product for its intended use. The user assumes all 
risks and liability whatsoever in connection with such use.

Use of the SurveyCERT™ software is bound by 
license agreement, a copy of which is included in the 
SurveyCERT™ download bundle.

Copyright Statement

This manual is Copyright © 2008 Radiodetection LTD. All 
rights reserved. Radiodetection LTD is a subsidiary of  
SPX Corporation.

Trademarks

SurveyCERT is a trademark owned by Radiodetection 
LTD, all rights reserved.

Windows, Windows Vista, Windows Mobile, ActiveSync 
and Microsoft Excel are registered trademarks of 
Microsoft Corporation, all rights reserved.

ArcGIS is a trademark of ESRI, all rights reserved.

MapInfo Professional is a trademark of MapInfo, all rights 
reserved.

The Bluetooth word mark and logos are owned by 
the Bluetooth SIG, Inc. and any use of such marks by 
Radiodetection Ltd. is under license.

Open Office Calc is an open source project released 
under the GNU Lesser General Public License.

Training

Radiodetection provides training services for most 
Radiodetection products. Our qualified instructors will 
train equipment operators or other personnel at your 
preferred location or at Radiodetection headquarters.

For more information go to www.radiodetection.com or 
contact your local Radiodetection representative.
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Section 1. – Introduction

Thank you for your interest in SurveyCERT™. The 
RD8000 platform provides fast locate and effective 
measurement of pipeline coating faults. Radiodetection 
has engineered the RD8000 to communicate with 
third-party devices such as PDAs using a Bluetooth® 
connection.

The free download bundle includes the following files:

This manual in PDF format

A readme file and EULA

The SurveyCERT™ PDA application

The SurveyCERT™ PC application

1.1 Overview

SurveyCERT™ is an application for Pocket PCs that can 
read and chart logged data from the RD8000 receiver in 
real-time. The application is also available as a desktop 
viewer for Microsoft Windows® XP™ and Vista™. This 
version is optimized for larger screens but includes all 
the features of the PDA version, including the ability to 
import logged data from the receiver via a Bluetooth® 
connection.

The PDA version is optimized for use on a VGA (or quarter 
VGA) PDA running Windows Mobile®. To maximise 
your experience using the software, Radiodetection 
recommends using the software with a Bluetooth® and 
GPS enabled PDA.

1.2 About this manual

This manual provides RD8000 users with instructions on 
how to use your Bluetooth® and GPS enabled Pocket PC, 
PDA or Smart Phone with the RD8000 Receiver.

Also included is a developer guide intended for GIS 
professionals. The guide provides a brief tutorial on 
how to convert the SurveyCERT™ data log to a format 
compatible with ESRI ArcGIS.

Section 2 provides users with installation instructions for 
desktop and Pocket PC systems.

Section 3 provides an overview of the PDA and PC 
program’s basic function.

Section 4 lists the range of charts offered with the various 

•

•

•

•

frequency modes supported by the RD8000 receiver.

Section 5 provides detailed instructions on bonding and 
using your Pocket PC with the RD8000 Receiver.

Section 6 gives an overview of the methods available for 
reading SurveyCERT™ logs on your PC or PDA.

Section 7 contains advanced GPS setup options.

Section 8 provides details on how to import the 
SurveyCERT™ data log into ESRI ArcGIS and Section 9 
contains Appendices for developers and advanced users.

1.3 Applications

The RD8000 is designed to be a flexible platform that is 
interoperable with a broad range of industry applications. 
One such application is the field of Geographic 
Information Systems (GIS). Broadly, GIS is a discipline 
dedicated to the analysis of spatial information that can 
be drawn from a wide range of sources, including GPS 
data, which is supported by SurveyCERT™.

Refer to Section 8 for an overview of using RD8000 locate 
data with ESRI ArcGIS.
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Section 2. – Installation

SurveyCERT™ runs on either a desktop/laptop PC or a 
Windows Mobile powered PDA or smart phone.

2.1 System requirements

Pocket PC

Windows Mobile 4.5 or later

Bluetooth® wireless module

GPS receiver (Optional)

PC

Microsoft Windows XP Professional with Service Pack 2*

Microsoft Windows Vista

USB Bluetooth® adapter (Optional)#

Microsoft .Net framework (or Visual C++ Redistribution 
Package)

*NOTE Windows XP 64bit is not supported at this time.

#NOTE Some internal PC Bluetooth modules may not be 
compatible. Radiodetection recommends using a USB 
Bluetooth adapter.

2.2 Installing on Windows
NOTE: SurveyCERT™ is also installed with the 
Radiodetection Enterprise Suite. You do not need to 
download SurveyCERT™ if you already have this on 
your system.

The PC application is distributed as a standalone 
executable file. Simply copy the file to your directory of 
choice and double click to run.

Note that to run the program you may also need to 
install the Microsoft Visual C++ redistribution Package, 
which is available as a free download from the Microsoft 
website. This package is not required if you have the .Net 
framework installed on your computer.

Note that at this time, Windows XP 64bit are  
not supported.

2.3 Installing on Pocket PC

To install the application on your Pocket PC device, 
you must use the Microsoft ActiveSync utility. This utility 
is usually installed with your Pocket PCs application 
suite otherwise you can download ActiveSync for free 
from the Microsoft website. Consult the documentation 
that accompanied your Pocket PC if you require more 
information.

Windows Vista users please note that you must 
synchronize your devise using Windows Mobile Device 
Center.
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Section 3. – Basic Operation

SurveyCERT™ is designed for rapid data capture and 
analysis in the field. Most functions can be accessed 
quickly using the toolbar. These functions are identical on 
the PDA and PC versions of the software.

There are several layout differences to note. The PDA 
version displays the file manager in a popup window and 
the PC uses a split window that can be adjusted using 
regular window handlers.

The PC version also features a Menu bar situated below 
the Title bar as with standard Windows applications. In 
the PDA version, the button is located on the Toolbar.

Figure 3.1: SurveyCERT™ PC Version Figure 3.2: SurveyCERT™ PDA 

1
1

Main/Chart Window

Toolbar

Status Indicators

File Manager

1.

2.

3.

4.

2

2
3

3
4

3.1 Main Menu (PC version)

Press the Menu button to display the following options:

Settings – opens the Settings window.

X-Axis – adjusts the Index and Distance values on 
the x-axis.

Autoscale – when On, forces the chart to automati-
cally resize around the current data. Select Off to 
turn Autoscale off.

Exit – Exits the program.

•

•

•

•
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3.2 The Toolbar

Menu (PDA only) – opens the settings window.

New – creates a new trace.

Open – opens an existing trace saved in the ENT file 
format.

Save – saves the current trace as an ENT file on 
your PDA.

Logging Toggle – when selected, this option sends 
data from the RD8000 receiver to your PDA.

Locator Mode Toggle – changes the currently dis-
played locator mode.

Chart Toggle – toggles the different charts available 
to each Locator Mode (refer to Section 4).

Grid Toggle – displays a latitudinal/longitudinal grid in 
the main window.

Range Toggle – displays the latitudinal/longitudinal 
range in the main window.

3.3 The Status Bar

The status bar on the bottom of the Main Window 
provides connection and co-ordinate information. The 
Status Bar includes the following indicators:

Bluetooth® indicator – indicates that a Bluetooth® 
connection is present. If this icon remains greyed 
out, check your connection settings.

GPS indicator – indicates that a GPS connection is 
present. If this icon remains greyed out, check your 
connection settings.

Locator Mode indicator – indicates the RD8000 
receiver’s current locator mode.

Zoom indicator – indicates the current x-axis and 
y-axis zoom settings.

Position Indicator – displays the graph co-ordinates 
when the stylus is pressed on the main window.

Log Indicator – Indicates whether the PDA is logging 
data from the RD8000 receiver. If either the GPS or 
Bluetooth® link is lost during logging, the application 
will continually attempt to re-establish the link.

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

3.4 Settings Menu

To access the Settings window on the PDA press the 
Menu button with your stylus; on the PC version select 
Menu -> Settings from the Main Menu bar. The Settings 
window allows you to configure the following options:

Grid – adjusts the number of longitude and latitude 
grid lines.

Colour – adjusts background and high/low value 
colors.

Ports – allows users to adjust the Bluetooth® and 
GPS port settings of the application. These set-
tings must match your PDA’s Bluetooth® and GPS 
receiver ports; otherwise the application may be un-
able to communicate with the RD8000 receiver and 
the GPS network.

Test – displays raw connection data as plain text in 
the main Window. Use this option to test or trouble-
shoot your Bluetooth® and GPS connections.

•

•

•

•

Figure 3.3: PC Settings Window
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3.6 File Manager

The File Manager displays the current active trace file 
along with any other trace files you choose to open. When 
you open the program, a temporary blank trace file is 
created, ready to receive data from the RD8000 Receiver. 
This file by default is the current active trace.

When a trace is active it can be edited with new trace 
data logged from the RD8000 Receiver.

The File Manager allows you to load multiple locate files 
and view them as an overlay on your current or active 
trace. You can open additional files by pressing the Open 
icon on the Toolbar and then selecting an existing ENT file 
from an earlier trace.

Once multiple files are open, you can define whether a file 
is visible on the main chart window, what color it is and 
whether the file is active or not. To adjust these settings 
on the PC version, Right Click the file name to display the 
context menu. From there you can Activate the file, delete 
it, display or hide it and change the color.

3.5 The Main Window

This window displays logged data in a range of charts. 
The window also features navigation and zoom buttons 
that allow you to pan or enlarge on a selected area. Press 
the Main Window with your PDA stylus to activate the 
context menu.

The context menu gives you the following options:

Settings – shortcut to the applications Settings 
Menu.

X-Axis Distance – sets the X-Axis of the chart to the 
distance of the first GPS co-ordinate.

X-Axis Index - sets the X-Axis to be a contiguous 
index for each data position in each locator mode. 
This mode is essential if GPS is unavailable or if GPS 
accuracy is insufficient.

Zoom In – zooms in at the selected point.*

Zoom Out – zooms out at the selected point.*

Horizontal Shrink – zooms in along X axis.*

Horizontal Stretch – zooms out along the X axis.*

Vertical Shrink – zooms in along Y axis.*

Vertical Stretch – zooms out along the Y axis.*

Recentre – centers the current view relative to the 
selected point.*

Restore – returns the Main Window to its default 
view.*

Autoscale – when On, forces the chart to automati-
cally resize around the current data. Select Off to 
turn Autoscale off.*

*Function not available when autoscale is enabled.

•

•

•

•

•

•

•

•

•

•

•

•
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Section 4. – Survey charts

The primary function of the desktop and PDA version of 
the software is to display locate data captured using the 
RD8000 receiver. As such, both platforms are able to 
display graphs corresponding to the frequency selection 
modes on the RD8000 receiver.

The following table shows what information is displayed 
by the various Locator Modes offered by the  
RD8000 receiver.

Table 4.1 Locator Mode Charts

Available charts

Mode Depth Locate I dBMV Phase TSG

8KFF • • •

POWER • •

CPS • • •

CDFF • • •

ACTIVE • • •

CD • • • •

The program allows users to import and chart survey data 
collected using the RD8000 receiver using a compatible 
PDA or PC. When used in the field with a Bluetooth® and 
GPS compliant device, the program will chart locate data 
in real-time using positional information. If using a PDA 
without a GPS receiver, the PDA will only log the  
receiver’s data. 

Once logged, you can send this data to a PC and use it 
with your company’s preferred GIS platform.
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Section 5 – Using the RD8000 receiver 
with a PDA

The portability of a PDA allows you to operate the 
RD8000 receiver and gain real-time information for 
extended periods in the field. If your PDA features a 
GPS receiver, SurveyCERT™ will automatically add GPS 
information. For information on the GPS data format, refer 
to Appendix 9.1.

5.1 Pairing the devices

Bluetooth® devices must be paired before use. The 
following procedure provides an example of how to pair 
the RD8000 receiver to your PDA. For more information, 
consult the RD8000 Operation Manual and your PDA’s 
documentation.

On the RD8000 receiver

Press the Power Key to switch on the unit.

Press the Power Key once and then press the UP 
Arrow Key once to display BLUT.

Press the Power Key once and then press the 
DOWN Arrow Key to display PAIR.

Press the Power Key once to enter Pair mode.

On your Pocket PC

Pair your Pocket PC to the RD8000 receiver with 
your Pocket PC’s Bluetooth® software. Note that 
the procedure for pairing your PDA differs with 
each model; consult the documentation that 
came with your PDA for more information. The 
following example should apply to most Pocket 
PCs running Windows Mobile 5.

From the Start menu on the PDA, select 
Settings, then select the Connections Tab and 
then select the Bluetooth® icon.

Ensure the Bluetooth® Radio is on and make 
the PDA visible to other devices

Select the Devices tab and scan for new 
partnerships.

Create a partnership with the RD8000.

Select the COM Ports tab and make a New 
Outgoing Port with the RD8000 (RD8K_xxxx 
where xxxx is the firmware version). Note the 
port number of the selected COM port.

1.

2.

3.

4.

1.

a.

b.

c.

d.

e.

Figure 5.1: Windows Mobile 5 
Bluetooth Manager

Once your PDA is paired with the RD8000 
receiver, you can toggle the receiver’s Bluetooth® 
mode to Auto. In Auto Mode, the receiver will 
attempt to connect to the paired PDA when the 
devices are within 10 meters of each other.

3.

5.2 Activate GPS (Optional)

If your PDA features an integrated or external GPS 
receiver you can log positional co-ordinates to your 
locate data gathered with the RD8000 receiver. Note that 
GPS functions differ in each PDA so check your PDA’s 
documentation if you need help establishing a link to the 
GPS network.

Once the GPS receiver is active, launch SurveyCERT™.

Note the Bluetooth® and GPS indicators beneath the 
status bar. If either connection is established, the icons 
will be bright blue. If there is no connection, the icons will 
be grayed out. Note that it may take several moments to 
find an active connection.

If the either connection is still inactive after several 
moments, check to ensure your GPS receiver is active 
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and your Bluetooth® radio is active and paired to the 
RD8000 receiver. If problems continue, you may have 
to alter the Bluetooth® and GPS port settings in the 
application’s Settings Menu (See Section 3.4).

5.3 Logging data in realtime

Once Bluetooth® and the optional GPS connections are 
established you can send data from the Receiver to your 
PDA using the following procedure:

Create a New Trace by clicking on the New 
Document icon on the SurveyCERT™ PDA 
toolbar. This creates a new active trace and 
ensures that any existing or older traces are not 
overwritten.

On the RD8000 receiver, select the SEND option 
from the settings menu. The Receiver will now 
attempt to stream data to any paired device.

On your PDA, enable Bluetooth® logging 
by pressing the Logging Toggle icon on the 
SurveyCERT™ PDA toolbar. This allows the PDA 
to receive data logs from the RD8000 Receiver.

Begin your survey with the RD8000 receiver and 
a Radiodetection transmitter as described in the 
RD8000 Operation Manual or User Guide.

When you find a reading you want to record, 
press and hold the Antenna Select key on the 
RD8000 receiver. The SurveyCERT™ bar graph 
will spike and then return to its previous value. 
The data will now be stored in your PDA’s memory 
and displayed in your current active trace.

Continue your survey and log your findings as 
described in Step 5.

Once the survey is completed, press the Disk icon 
on the SurveyCERT™ PDA toolbar to save the 
survey data as a ENT file on your PDA.

Once saved you can open the file using 
SurveyCERT™ on your PDA or desktop 
software or export it for analysis in your preferred 
spreadsheet or GIS application.

1.

2.

3.

4.

5.

6.

7.

8.

Troubleshooting Log Connections

If you have correctly established the Bluetooth® and 
optional GPS connections but cannot receive logged 
data, please check the following:

Make sure the SurveyCERT™ PDA application is set 
to receive data by press the Log mode button on the 
toolbar.

Make sure the SurveyCERT™ PDA application is set to 
the same locate mode as the receiver. If the modes are 
different the PDA will still record the data however it will 
not be displayed on-screen.

If you have trouble logging in realtime, you can conduct 
your survey and send the data to your PDA or PC later.

Note that the graph doesn’t display data until a second 
measurement is taken.
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Section 6 – Using the RD8000 receiver 
with your PC

You can send data from the RD8000 receiver straight to 
your Bluetooth® compliant desktop or laptop PC. To do 
this you must first pair the two devices. Once paired the 
Bluetooth® link will allow you to send logged data to your 
PC where you can read it using the SurveyCERT™ PC 
application or import it into your preferred GIS platform.

6.1 Pairing

Bluetooth® devices must be paired before use. The 
following procedure provides an example of how to pair 
the RD8000 Receiver to your PC. You can make the 
connection using a USB Bluetooth® adapter providing it 
supports the Bluetooth® Serial Port profile.

Note that the steps for pairing Bluetooth® devices may 
differ depending on the brand of computer or the USB 
adapter you have. As such, the following procedure is a 
guide only.

For more information, consult the RD8000 Operation 
Manual and your PC or Bluetooth® module’s 
documentation.

On the RD8000 receiver

Press the Power Key to switch on the unit. 

Press the Power Key once and then press the UP 
Arrow Key once to display BLUT.

Press the Power Key once and then press the 
DOWN Arrow Key to display PAIR.

Press the Power Key once to enter Pair mode.

On your PC

Connect a USB Bluetooth® adapter that supports 
the Bluetooth Serial Port Profile into a USB port.

Alternatively if your PC features an integrated 
Bluetooth® module, switch it on following the 
documentation that came with your computer.

Select Start -> Control Panel and double click on 
‘Bluetooth Devices’.

Click on Add to run the ‘Add Bluetooth Device 
Wizard’.

Tick ‘My device is set up and ready to be found’ 
and click Next to search for Bluetooth® devices.

1.

2.

3.

4.

1.

a.

2.

3.

4.

A device named RD8K_xxxx should appear, if it 
doesn’t make sure the RD8000 receiver is in Pair 
Mode and click Search Again.

Select the RD8k_xxxx and click Next.

Tick ‘Use the passkey found in the 
documentation’, enter 1234 for the passkey and 
click Next to pair with the RD8000 receiver.

Completing the Add Bluetooth Device Wizard will 
be displayed for a successful pairing.

Note the Incoming COM port assigned to the 
device and click Finish.

6.2 Advanced Settings

Once paired, you must check to see if your PC’s 
Bluetooth® port is configured to the same Baud rate and 
parity settings. These settings can be adjusted as follows:

Right-click My Computer and select Properties.

Select the Hardware tab and then select Device 
Manager.

Expand the Ports(COM & LPT) menu tree 
and double-click the device assigned to the 
Bluetooth® Incoming port.

Select the Port Settings tab and set:

Bits per second to 115200,

Data bits to 8,

Parity to None,

Stop bits to 1 and

Flow control to Hardware.

Click OK to return to the Device Manager.

Close the Device Manager.

5.

6.

7.

8.

9.

1.

2.

3.

4.

a.

b.

c.

d.

e.

5.

6.
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6.3 SurveyCERT™ PC configuration

Once the connection is established and you have 
configured your Bluetooth® port settings, you must now 
configure the SurveyCERT™ PC application to receive 
data on the selected Bluetooth® port. To do so, please 
use the following procedure.

If you haven’t already, open the SurveyCERT™ 
PC application by double-clicking its icon; this will 
create a settings file,

Close the SurveyCERT™ PC application,

Locate the settings file, SurveyCERTIni.txt in the 
directory where you installed the SurveyCERT™ 
PC application,

Open the settings file in Notepad,

Find the line  
PORT#BLUETOOTH#PORTNUMBER#,

Add the correct port number to the end of the 
line,

Note if your PC is connected to a Bluetooth® 
GPS receiver, you can also add the port 
number the GPS device is using in the line 
PORT#GPS#PORTNUMBER#

Save the file and exit; you may now reopen 
SurveyCERT™ on you PC.

1.

2.

3.

4.

5.

6.

7.

8.

6.4 Receiving Data

Once the connections are established, you can send the 
logged data from the RD8000 receiver to the  
PC application.

To do so:

On the SurveyCERT™ PC application, create a 
new trace and press the Log button on the tool 
bar.

On the RD8000 receiver select the SEND option 
from the settings menu.

If the connection is successful, the PC 
application’s Bluetooth® icon will become active 
and the logged data will appear on-screen.

Check to see if all data has transferred by toggling 
through the receiver modes on the SurveyCERT™ 
PC Application.

Save the file by selecting Save As from the  
File Menu.

1.

2.

3.

4.

5.
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Section 7. – Reading data

You can read logged data in several ways. You can use 
the SurveyCERT™ PDA application to read data in real-
time or open previous trace files. For large screen viewing, 
you can save the date to your laptop to desktop PC and 
open it using the SurveyCERT™ PC version. Alternatively, 
you can view and manipulate the raw data in a plain text 
editor or CSV compatible spreadsheet application such 
as Microsoft® Excel™ or Open Office Calc.

7.1 Real-time viewing

You can view the logged data as you record it in real time. 
This process occurs automatically when a recorded log is 
sent from the RD8000 receiver to the PDA. Each data log 
will appear in the active trace window as a vector or point, 
depending on the chart mode you have selected. You can 
compare an active trace to historical traces saved on your 
PDA, providing you with rapid analysis in the field. Refer 
to Section 4 for a list of supported charts.

7.2 Desktop viewing

Away from the field, you have the option to view one or 
more traces on a desktop or laptop computer using the 
SurveyCERT™ PC viewer. The desktop viewer provides 
you with the same analysis tools but utilizes the desktop’s 
larger screen environment. Refer to Section 4 for a list of 
supported charts.

7.3 Raw data view

If required, you can view the raw data log in a plain text 
editor or any spreadsheet application that supports CSV 
plain text import. Microsoft Excel and Open Office Calc 
are both capable of importing CSV data. This allows you 
to format the data for use in GIS applications such as 
ESRI ArcGIS or MapInfo Professional. 

Figure 7.1: Reading locate 
data on the PDA
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Section 8. – Advanced GPS setup

To use GPS with SurveyCERT™ on your PDA, you may 
have to map your PDA’s GPS port to match those found 
in the SurveyCERT™ setup menu. Alternatively, if your 
PDA does not permit you to change its GPS port, you can 
change the port settings found in the settings menu of 
SurveyCERT™.

Note GPS settings will differ depending on your PDA’s 
brand and as such this information is intended as a guide 
only. Consult your PDA’s user documentation for more 
information.

8.1 Configuring GPS port settings

From your PDA’s Start menu, select Settings, then 
select the System Tab and then select the GPS 
icon.

In the GPS settings page, go to the Programs 
Tab.

Note the GPS COM port number and Baud 
rate. An example is shown in Figure 7.1.

If applicable, ensure that this port is enabled.

Advanced users only. If necessary, change this 
port number and baud rate to match the settings 
in the SurveyCERT™ settings menu.

8.2 SurveyCERT™ GPS settings

Check the port number and baud rate of your 
PDA’s GPS receiver.

Open SurveyCERT™ and press the Menu button 
on the toolbar.

Select the Ports Tab. The PC settings page is 
shown in Figure 7.2 as an example.

If necessary, change the GPS port number and 
baud rate to match the GPS receiver’s settings.

Select the Test Tab and check the GPS box (and 
Bluetooth® if required).

Press OK; if the connection is successful, 
the main window will display raw GPS (and 
Bluetooth®) data.

1.

2.

a.

3.

4.

1.

2.

3.

4.

5.

6.

Figure 8.2 GPS and 
Bluetooth® Port settings

Figure 8.1 Windows Mobile 
GPS Setup
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Section 9. – ESRI ArcGIS

This section provides an example of how to format the 
R8000 data log for export into ESRI ArcGIS.

The RD8000 receiver stores data as comma-separated 
variables (CSV); the data is then saved as a plain text 
file with a .ENT extension. The CSV format allows you to 
import the tabular data to ArcView where you can then 
convert the data to a shape file and manipulate the trace 
as a map layer.

Note that there are several methods for using the RD8000 
data in your GIS environment; the method outlined here is 
intended as an example workflow only.

9.1 Formatting the ENT file

The ENT file is saved in CSV format with a .ENT 
extension. Before importing the data into ArcView you 
must add table headers to the data and give the file a 
CSV extension. You can do this manually in any plain 
text editor or in a spreadsheet application that supports 
the CSV format. The example uses Microsoft Excel 2003 
and 2007, however the process should be similar in older 
versions of Excel and Open Office Calc.

Formatting in Excel

Copy the ENT file from your PDA or the RD8000 
Receiver to your computer using Bluetooth® or 
ActiveSync (Pocket PC only).

Open Microsoft Excel and create a new 
spreadsheet.

In Excel 2003 and earlier, select Data -> Get 
External Data -> Import Text File.

In Excel 2007, select the Data tab and click From 
Text.

When the Import File dialogue box appears, 
choose All Files from the Type of Files drop-down 
box. Next, navigate to the ENT file, select it and 
press Import.

Excel will then display a Text Import Wizard.

On the first screen, select the Delimitated radio 
button. Next, choose which row you want the 
data to begin at. Row 2 is recommended as you 
will need to add the header columns. For file 
origin, the default value is usually correct.

1.

2.

3.

4.

5.

6.

7.

Press Next.

In Screen 2, select Comma as the delimiter and 
deselect all other delimiters. You should now see 
a preview of your formatted data.

Press Next.

Screen 3 allows you to change the cell type 
of each column. In almost all applications, it is 
sufficient to leave the default General cell type.

Press Finish.

Excel will now import your data beginning at the 
row you selected. If you chose Row 2, you will 
have an empty row in which to add the headers. If 
you specified Row 1 then you will have to insert a 
new row above your data.

Adding headers.

ArcView and other ESRI programs require that 
headers are added to CSV files. The ENT file does not 
include headers and so they must be added manually. 
Alternatively, you could create a template with the headers 
in place or you could automate the process using VBA.

Note that you can give the headers any name you wish, 
however for ESRI programs they must be in CAPS and 
contain no spaces.

Although the headers are not logged with the file, 
SurveyCERT™ always logs the data in the same format 
using pre-existing headers within the RD8000 receiver. 
These headers are detailed in Appendix 9.1.

Once you have added headers you should then save the 
data as a CSV file. You are now ready to import the data 
to ArcView using the following procedure.

8.

9.

10.

11.

12.

13.
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9.3 Importing data to ArcGIS

Open ArcMap. You can add the data to a new 
map project or to an existing one. If you have 
existing map data for your survey area, you can 
overlay one or more RD8000 location datasets 
into your project for analysis.

To import the data go to Tools -> Add XY data...

Select Choose File and select your formatted CSV 
file using the file browser.

Once the file is selected you must then specify 
your X and Y fields using the drop down menus. 
The menus will list the headers you added in 
Excel. Choose the headers most applicable 
to your application (usually the Longitude and 
Latitude data).

Next select the projection appropriate to  
your survey.

Press Done, ArcMap will now import the data as a 
layer in your project.

You can now save the layer as a shape file by 
right-clicking the layer and selecting Data -> 
Export Data. Choose a file name for the new 
shape file and ensure the Import check box is 
selected. Press Save.

Your map will now contain a new shape file layer that you 
can manipulate according to your requirements. You can 
now safely discard the CSV layer and save your project.

1.

2.

3.

4.

5.

6.

7.
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Section 10. – Appendix

10.1 ENT file format

This appendix provides developers with detailed 
information on the SurveyCERT™ data format. The 
RD8000 stores locate information as comma separated 
variables using a plain text file with the extension, ENT.

These variables are formatted according to predefined 
headers that carry data specific to the RD8000 receiver’s 
trace information. The file also contains GPS header 
information based on the NMEA specification. Note if a 
GPS receiver is not used during the survey, the GPS value 
data will default to NULL or 0 values.

The headers are implied and are not included in the ENT 
file. This allows developers to define custom headers that 
best suits their host application.

Table 10.1 (overleaf) displays header information in the 
Data column. The Values column lists the type of data 
contained in each entry with an explanation where 
applicable.

10.2 PDA Resolution

By default the PDA is set to display at VGA resolution 
(640x480 pixels). If your PDA does not support this 
screen size you have the option to change the size of the 
application to quarter VGA. This option cannot be set in 
the application itself; to do so you must edit the program’s 
settings file using the following procedure.

First shut down the PDA application.

Locate the SurveyCERTIni.txt file on your PDA. 
Note this file is created at first runtime and is 
usually stored in the location of the exe file.

Open this file in any plain text editor.

Find the line: SCREEN#RESOLUTION#FULL

Change to SCREEN#RESOLUTION#QUARTER 
and be sure to use all caps.

Save and close the file.

Re-launch the PDA program; the window size 
should now fit you PDA screen.

1.

2.

3.

4.

5.

6.

7.

10.3 Setting receiver model

The ini file should be set to reflect your receiver model.

Open the ini file in Notepad or any plain text editor

Find the line: UNIT#MODEL#<string>

Replace the string, if present, with your correct 
model type i.e. either:

RD8000PXL

RD8000PDL

1.

2.

3.

a.

b.
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Table 10.1 ENT data format

Col # Data Values Comments

RD8000 logging data

1 Locator mode <String> Specifies the locate mode 
when reading was taken

2 File Index <Integer>

3 Locate Depth <Float> Depth in meters

4 Locate Current <Float> Current in mA

5 Phase <Float> Phase in degrees

6 Signal <Float> Signal level in dBmV

7 Signal strength <Float>

8 Gain <Float>

Optional GPS Data

9 GPS UTC <Double> GPS Universal Time Code

10 GPS Latitude <Double> Latitude in degrees

11 GPS Latitude Direction 0 – Unknown
1 – North
2 – South
3 – West
4 – East

12 GPS Longitude <Double> Longitude in degrees

13 GPS Longitude Direction 0 – Unknown
1 – North
2 – South
3 – West
4 – East

14 GPS Fix Quality 0 – None 
1 – GPS
2 – DGPS
3 – PPS
4 – Kinematic
5 – RTK
6 – Estimated
7 – Manual
8 – Simulation

Specifies the type of precision 
used

15 GPS Number of Satellites <Integer>

16 GPS Horizontal Dilution <Double>

17 GPS Altitude <Double> Altitude in meters

18 GPS Altitude Units 0 – Invalid 

1 – Meters

19 GEO ID Height <Double>

20 GEO ID Units 0 – Invalid 

1 – Meters

21 DGPS Time since Update <Integer> Time in seconds

22 DGPS Station ID <Integer>

23 Time 0 – System
1 - GPS

Specifies if the time is set by 
the GPS network or by the 
GPS receiver’s internal clock

24 Day Integer Day of Month (1-31)

25 Month Integer Month of Year (1-12)

26 Year Integer 4 Digit Year
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